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File menu commands

The File menu offers the following commands:

Save This command is used to save the query result as a text file, in a detailed format

Retrieve This command is used to either retrieve the selected file or expand a directory, 
depending on what is selected in the file list box.

If a file is selected in the list (check the file name box, if the file is prepended 
with FILE:, then it's a file) then WSARCHIE can be set up to use WS_FTP to 
retrieve the selected file. See FTP Setup also.

Can be selected by double-clicking the file name in the file list box or the file 
name box.

Expand Expands the selected directory in the directory list box. Note the difference 
between this option using the directory selected in the directory list box and that 
above, which uses a directory selected in the file list box.

Can be selected by double-clicking the directory name in the directory list box.

Exit Exits WSARCHIE.



Options menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

User Preferences Allows the user to specify default Archie server and search type.

FTP Setup Allows the user to setup the command used to retrieve files, and 
also to specify his identity.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.

Using Help Provides general instructions on using help.

About Displays the version number of this application.



Save command (File menu)

Use this command to save the result of the query. The format used is similar to the usual long listing form 
used by archie servers.

Selecting the command will bring up a save file dialog.    The usual rules apply here.



Retrieve command (File menu)

Use this command to retrieve the selected file (note if the file is a directory then the directory will be 
expanded, ie a list of the files in the directory will be retrieved from the Archie server. Note also that at the 
moment the list of files does not have the attributes Archie Date and the host internet address).

See WS_FTP and FTP Setup for details on configuring FTP details.

Shortcuts
Double click on the file name in the list of files or the filename box.



Expand command (File menu)

Expands the selected directory in the directory list box. Note the difference between this option using the 
directory selected in the directory list box and that above, which uses a directory selected in the file list 
box.

Shortcuts
Can be selected by double-clicking the directory name in the directory list box.



Exit command (File menu)

Use this command to end your WSARCHIE session.    You can also use the Close command on the 
application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



User Preferences (Options menu)

When this command is selected the following Dialog will appear:

The selections for default Archie server and default search method will be stored and used as the default 
startup values, next time you run WSARCHIE.

The User ID field is used in the Archie Request to identify you. This does not need to be changed from 
'nobody', the default value.



FTP Setup (Options menu)

This command displays the following dialog:

The command field should be tailored to give the full path name for the FTP program, eg. "C:\FTP\
WS_FTP". The following special entries in this box will be substituted when an FTP request is made.

%h the host name
%d the directory name
%f the file name
%u the user name field as entered in the user name field
%p the password field as entered in the password field

Note the default entry will work without modification if WS_FTP.EXE is in the command path. Note also 
the "/" between "%d" and "%f", used to make up the full path name of the file. The ":" is specific to 
WS_FTP.

Note: WS_FTP does not take the username and password from the command line, but has it's own 
configuration details.

The Directory field should be filled in with the name of the directory that you wish files to be retrieved to. 
No check is made to see if the entry is valid, and if it does not exist it will not be created and you will not 
be able to perform FTPs, using WSARCHIE. The default value is '.' or the current directory.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using WSARCHIE and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the following dialog:

See Copyright for fuller details on the copyright notices from the University of Southern California and the 
University of Washington.



Performing an Archie Query

1. To perform a query enter a search string in the Search for box.

2. Select an archie server from the archie server drop down list.

3. Enter a match domain if desired, eg "uk" to restrict the search to entries for hosts end with 
"uk" or "src.doc.ic.ac.uk" to restrict the search to the that site.

4.
To start the query press return, Alt+E or use the mouse on the "Search button" . 
The "Search for", "Archie Server" and "Domain" boxes are disabled along with the search 

type radio buttons and the "Search" button. The "Abort"  button is enabled.

If desired the user may abort the search at any stage by pressing Alt+B or by selecting the "Abort" button.

Whilst the query is being performed, various status indications are given in order that the progress of the 
query may be seen. The indications are in the status bar, and also in the title bar of the application. The 
following is a brief description of the stages of an archie query

1. A name look up is done to translate the name of the archie server to numeric form.

2. When this completes a request is put together and sent to the archie server. At this point 
the title bar changes and will give the name of the archie server along with the initial time 
out period. If no response is received, the time period is doubled and the request re-
transmitted. This will be repeated up to three times before the request is deemed to have 
failed.

3. If a packet is received, the archie server will send back an acknowledgment from which 
may contain queue position and system time. You will not be advised of any changes in 
either of these, as they are sent once only by the archie client. The values returned are 
displayed in the status bar. The time out period will also be set to a value advised by the 
archie client, usually 900s if it your query is not going to be performed immediately.

4. The next packet from the archie server usually adjusts this to 180s and is a good indication 
that your query is now being processed.

5. When packets start to arrive the time out is then reduced to 5s and the packets received 
are indicated in the status bar. When the total number of packets is known this will be 
displayed as "packet x of y", otherwise "packet x" is displayed.

6. When the last packet is received, WSARCHIE will translate the results. If there are a large 
number of matches, this can take several seconds.

7. The results will then be displayed in the Hosts, Directories and Files list boxes. The first 
host will be displayed selected. The directories on that host that contain matches are then 
displayed with the first directory selected. The files in that directory are then displayed with 



the first file selected. Further details on the selected file are displayed in the file details 
section.

Search Type

The type of search performed by the archie client is determined using the search type radio buttons.

The choices have the following effects:

Substring: A simple, everyday substring search. A match occurs if the file 
(or directory) name in the database contains the user-given 
substring.

Substring (case sensitive): As above but the case of the strings involved becomes 
significant.

Exact: The fastest search method of all. The restriction is that the user 
string (the argument to the 'prog' command) has to exactly 
match (including case) the string in the database. This is 
provided for those of who know just what you are looking for.

Regex: Use ed(1) regular expressions. Searches the database with the
user (search) string which is given in the form of an ed(1) 
regular expression.

NOTE: Unless specifically anchored to the beginning (with ^) or
end (with $) of a line, ed(1) regular expressions have ".*" 
prepended and appended to them. For example, the following 
are equivalent

.*xnlock.* and xnlock

Thus the regex match becomes a simple substring match.

For example:

knob - matches any string containing the substring 'knob'

a*splat - matches strings that contain zero or more a's followed
by the string 'splat'

#.*# - would match anything containing a '#' followed by zero or 
more occurrences of _any_ character, followed by another '#'

Other special characters that may be useful are '[' and ']', which
are used together. They can be used to specify either a set of 
characters to match or a set of characters to not match. An 
example of the first case is:



[abcd]

which matches any of one of the four letters, while an example 
of the second case is:

[^abcd]

in which the '^' in the first position means that any character 
not in the list will be matched.

Ranges can be specified with a '-'.

[a-z]

matches any lower case letter and,

[^a-z]

matches any character other than a lower case letter. 
Furthermore, you can specify multiple ranges such as:

[%@a-z0-9]

or

[^A-Za-z]

meaning: match '%' or '@' or any lower case letter or digit, and 
match any character other than a letter, respectively.

When you want to match a character which has a special 
meaning you should precede it by a back slash, '\'.

Some final examples of REs are:

[Mm]ac\.txt - match anything containing the string "Mac.txt" or 
"mac.txt"

[^aeiou][^aeiou]* - match any string consisting entirely of non-
vowels

foo-v[0-9]\.tar\.Z - match "foo-v0.tar.Z" through "foo-v9.tar.Z"

Exact first This is a check box and is means that the exact search method 
will be used first. If no matches are found then the method 
selected using the radio buttons will be used. This box is 
disabled if the exact search method is chosen.

Note that changing the search type selected after the search is performed will have no effect on the 
displayed list of matches.



Archie Server

This drop down list box contains the list of archie servers that are in the "Archies" section of the file 
"WSARCHIE.INI" (NB this file must be in either WSARCHIE's working directory, the windows directory or 
the same directory as the program). The default archie server is displayed in the box when the program is
first started.

The list supplied is that given by archie.doc.ic.ac.uk at the time of release. '*' after the name of a server 
means that it uses V3 of the Archie software. This is for information purposes only and is not used in any 
way by WSARCHIE to perform the query.

When the search is started, the Archie Server name is truncated at the first '*' or white space (tab or 
space) in the name.

If you wish to add an Archie Server that is not listed, add a new line in the 'Archies' section of 
WSARCHIE.INI in the form 'xxxxxxx=aa.bb.cc.dd'. 'xxxxxxx' should be substituted with a name that is 
unique within the 'Archies' section. The position in the section will be the position that the Archie server 
name appears in the list, eg

my_special_archie=archie.of.my.heart      My Own Country

There does not need to be a country or area name appended, but if there is it should be separated from 
the server name with at least one space or tab.



Domain

This field is used to restrict the search to a subset of hosts within a particular domain, eg ".ac.uk" will 
restrict the search to academic sites in the UK.



Hosts

This is used to display the list of hosts with files or directories matching the search term.

The directories on the selected host containing directories or files that match the search term are 
displayed in the Directories list box. Selecting a new host will cause the Directories list box to be updated.



Directories

This is used to display the list of directories for the current selection in the Hosts list containing files or 
directories that match the search term.

The files within the selected directory are displayed in the Files list. Selecting a new list will cause the 
Files list box to be updated.



Files

This is used to display the list of files for the current selection in the Directories list box that match the 
search term. Further details for the selected file are displayed in the file details section.

Double clicking on a file in this list will initiate the FTP command (except in the case of a directory, when 
the directory will be expanded. Note also that at the moment the list of files does not have the attributes 
Archie Date and the host internet address). See the File menu Retrieve command 



Aborting a query

A query can be aborted at any stage by pressing Alt+B or selecting the "Abort" button .

Any information retrieved will be lost.



File details

This section of the result display contains the following fields:

File Name This is the full name of the file. It is prefixed with "FILE: " if it is a file and 
"DIRECTORY: " if it is a file.

Size This is the size of the file in bytes.

Mode This is the access mode of the file.

Date This is the files own date stamp.

Archie Date This is the date that archie server last checked the files existence.

Host Address This is the numeric internet address of the host upon which the file resides.

FTP
Files can be retrieved using a suitable FTP program. Use the FTP Setup command from the Options 
menu to setup a suitable command line.

This command will be executed when a filename is double clicked in the Files list, or the Retrieve 
command from the File menu is selected.

The default setup is to use WS_FTP.



Status Bar

The three boxes at the end of the status bar are used as follows (going from right to left):

The time that the archie server thinks it will take to process the query, when it starts the query.

The queue position when the query is received

The number of packets received.



Copyright

This archie client is base upon the archie client that is included as part of the Prospero V5.2a release. 
Prospero comes with two copyright notices as follows:

University of Southern California:

/* 
  Copyright (c) 1991, 1992, 1993 by the University of Southern California
  All rights reserved.

  Permission to use, copy, modify, and distribute this software and its
  documentation in source and binary forms for non-commercial purposes
  and without fee is hereby granted, provided that the above copyright
  notice appear in all copies and that both the copyright notice and
  this permission notice appear in supporting documentation. and that
  any documentation, advertising materials, and other materials related
  to such distribution and use acknowledge that the software was
  developed by the University of Southern California, Information
  Sciences Institute.  The name of the University may not be used to
  endorse or promote products derived from this software without
  specific prior written permission.

  THE UNIVERSITY OF SOUTHERN CALIFORNIA makes no representations about
  the suitability of this software for any purpose.  THIS SOFTWARE IS
  PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES,
  INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
  MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

  Other copyrights might apply to parts of the Prospero distribution
  and are so noted when applicable.

  Prospero was originally written by Clifford Neuman.
  Contributors include Steven Seger Augart, Benjamin Britt
  and others identified in individual modules.

*/

University of Washington

/* 
  Copyright (c) 1989, 1990, 1991 by the University of Washington

  Permission to use, copy, modify, and distribute this software and its
  documentation for non-commercial purposes and without fee is hereby
  granted, provided that the above copyright notice appear in all copies
  and that both the copyright notice and this permission notice appear in
  supporting documentation, and that the name of the University of
  Washington not be used in advertising or publicity pertaining to
  distribution of the software without specific, written prior
  permission.  The University of Washington makes no representations
  about the suitability of this software for any purpose.  It is
  provided "as is" without express or implied warranty.

  Prospero was written by Clifford Neuman.

*/



WS_FTP

WS_FTP is a WINSOCK compliant FTP client program written by John A. Junod. It is obtainable via FTP 
from many sites worldwide. The latest copy is usually available on ftp.usma.edu in /pub/msdos as 
ws_ftp.zip




